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1 Install the software

Installing the Darwin VDP software on a Windows-
based computer

Software and hardware requirements

Software

● Adobe InDesign software (it is recommended that you install the
entire Adobe InDesign CS4/CS5 software package)

● One of the following versions of the Microsoft Windows operating
system:

○ Microsoft Windows XP with Service Pack 2 (Service Pack 3
recommended)

○ Microsoft Windows Vista with Service Pack 1
○ Microsoft Windows 7 (both 32 bit and 64 bit)

Hardware

● Intel Pentium 4 or AMD Athlon 64 processor
● 1GB of RAM (2GB recommended)
● 1,024x768 display (1,280x800 recommended) with 16-bit or greater

video card
● DVD-ROM drive
● 1.6GB of available hard-disk space for installation; additional free

space required during installation (InDesign cannot be installed on
flash-based storage devices)

Note: Make sure that your computer complies with the software and hardware
requirements for the Adobe InDesign CS4 or CS5 software.



Installing the Darwin VDP software version 3.1
Requirements:

● Your hardware and software must meet the requirements for the
Kodak Darwin VDP software. These requirements include the
Adobe InDesign CS4/CS5 software, which must be installed on
your computer.

● If the Darwin VI Authoring Tool for InDesign version 2.0 is installed
on your computer, and you want to install Darwin VDP software
version 3.1 on the same computer, you must follow a different
installation procedure.

● If a previous version of Darwin VDP software version 3.1 is installed
on your computer, you must remove that version.

1. Copy the Darwin VDP software installer file from the DVD to your
computer.

2. Double-click the Darwin VDP software installer file.
The Darwin VDP software Installer Wizard appears.

3. Follow the instructions in the wizard.
The software is installed, and a shortcut to the Darwin VDP
software version 3.1 appears on your desktop.

Installing the Darwin VDP software version 3.1 without removing a
previous Darwin version

Keep the Darwin VI Authoring Tool for InDesign version 2.0 on your
computer when you install Darwin VDP software version 3.1 so that
you can work with both versions.

Requirements:

Note: Darwin version 3.0 and 3.1 cannot reside on the same computer. When you
install Darwin version 3.1, the previous version 3.0 is upgraded to 3.1.

● Your hardware and software must meet the requirements for the
Darwin VDP software. These requirements include the Adobe
InDesign CS4/CS5 software, which must be installed on your
computer.

● If a previous version of the Darwin VDP software version 3.1 is
installed on your computer, you must remove that version.

Note: Although this procedure describes how to install Darwin VDP software
version 3.1 while keeping the Darwin VI Authoring Tool for InDesign version 2.0 on
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the same computer, it is recommended that you install only one version of the
Darwin software on a computer.

1. Copy the Darwin VDP software version 3.1 Installer file from
the DVD to your computer.

2. Double-click the Darwin VDP software Installer file.

3. If the Darwin VDP software Installer detects previous versions of
the Darwin VDP software, a message prompts you to back up your
previous version.

4. In the Question window, click Yes.

Note: If you click No, the installation process stops.

The Darwin VDP software version 3.1 Installer Wizard appears.

5. Follow the instructions in the wizard.

● The Darwin VDP software version 3.1 is installed.
● A shortcut to the Darwin VDP software version 3.1 appears on

your desktop.
● Your Darwin VI Authoring Tool for InDesign version 2.0 plug-ins

are backed up.

Removing the software

1. From the Start menu, select Settings > Control Panel > Add or
Remove Programs.
The Add or Remove Programs window appears.

2. In the Currently installed programs list, select Darwin VDP
software version 3.1, and click Remove.
A Darwin VDP software message prompts you to confirm that you
want to completely remove the application and its features.

3. Click Yes.
The Darwin VDP software is uninstalled.

4. To complete the process, in the Darwin VDP software Wizard, click
Finish.

The Darwin VDP software version 3.1 has been removed from your
computer.

Removing the software 3



Installing the Darwin VDP software on a Mac OS
computer

Requirements

Software

● Adobe InDesign CS4/CS5 software
● Mac OS X v10.5.7–10.6.x

Hardware

● 1GB of RAM (2GB recommended)
● 2.6GB of available hard-disk space for installation; additional hard-

disk space required during installation (InDesign cannot be installed
on a volume that uses a case-sensitive file system or on flash-based
storage devices.)

● 1,024x768 display (1,280x800 recommended) with 16-bit or
greater video card

● DVD-ROM drive

Note: Make sure that your computer complies with the software and hardware
requirements for the Adobe InDesign CS4/CS5 software.

Installing the Darwin VDP software version 3.1
Requirements:

● Your hardware and software must meet the requirements for the
Darwin VDP software. These requirements include the Adobe
InDesign CS4/CS5 software, which must be installed on your
computer.

● If the Darwin VI Authoring Tool for InDesign version 2.0 is installed
on your computer, and you want to install Darwin VDP software
version 3.1 on the same computer, you must follow a different
installation procedure.

● If a previous version of Darwin VDP software version 3.1 is installed
on your computer, you must remove that version.
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1. Copy the Darwin VDP software installer file from the DVD to your
computer.

2. Double-click the Darwin VDP software installer file.
The Darwin VDP software Installer Wizard appears.

3. Follow the instructions in the wizard.
The software is installed, and a shortcut to the Darwin VDP
software version 3.1 appears on your desktop.

Installing the Darwin VDP software version 3.1 without removing a
previous Darwin version

Keep the Darwin VI Authoring Tool for InDesign version 2.0 on your
computer when you install Darwin VDP software version 3.1 so that
you can work with both versions.

Requirements:

Note: Darwin version 3.0 and 3.1 cannot reside on the same computer. When you
install Darwin version 3.1, the previous version 3.0 is upgraded to 3.1.

● Your hardware and software must meet the requirements for the
Darwin VDP software. These requirements include the Adobe
InDesign CS4/CS5 software, which must be installed on your
computer.

● If a previous version of the Darwin VDP software version 3.1 is
installed on your computer, you must remove that version.

Note: Although this procedure describes how to install Darwin VDP software
version 3.1 while keeping the Darwin VI Authoring Tool for InDesign version 2.0 on
the same computer, it is recommended that you install only one version of the
Darwin software on a computer.

1. Copy the Darwin VDP software version 3.1 Installer file from
the DVD to your computer.

2. Double-click the Darwin VDP software Installer file.

3. If the Darwin VDP software Installer detects previous versions of
the Darwin VDP software, a message prompts you to back up your
previous version.

4. In the Question window, click Yes.

Note: If you click No, the installation process stops.

The Darwin VDP software version 3.1 Installer Wizard appears.

5. Follow the instructions in the wizard.

● The Darwin VDP software version 3.1 is installed.
● A shortcut to the Darwin VDP software version 3.1 appears on

your desktop.
● Your Darwin VI Authoring Tool for InDesign version 2.0 plug-ins

are backed up.

Installing the Darwin VDP software version 3.1 without removing a previous Darwin version 5



Removing the software
Requirements:

The Darwin VDP software version 3.1 and the Adobe InDesign CS4/
CS5 software must be closed.

1. In the InDesign CS4/CS5 Installation folder, delete the
following folders:

○ Darwin Pilot
○ DarwinLibs
○ Darwin Documentation
○ Darwin Backup

2. In the InDesign CS4/CS5 Installation\Plug-Ins folder,
delete the Darwin folder.

3. In the InDesign CS4/CS5 Installation\Fonts folder, delete
the Darwin folder.
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2 Overview of the Darwin
VDP software

What is Darwin?
The Darwin VDP software is authoring software that facilitates the
process of merging variable data with a design to produce high-quality
variable printing jobs. The Darwin VDP software enables you to create
full-color postcards, coupons, newsletters, proposals, and more,
completely customized for each recipient. Any amount of text and
graphics can differ on each page for each recipient. The variable content
is based directly on your data or on rules you define. You can also
specify rules to select which layout(s) is used for each reader.

The Darwin VDP software can output standard PDF or Adobe
PostScript files for proofing. However, for rapid and efficient printing,
the Darwin VDP software can generate output variable data printing
(VDP) files for use on digital printers. Darwin supports all leading VDP
file formats: Creo VPS, Xerox VIPP, PPML, and PPML/VDX.

The Darwin VDP software consists of two major components:

● Darwin Pilot, stand-alone software that enables you to manage your
job data, job logic, and production sequence

● Darwin CoPilot, Darwin plug-in module for the InDesign CS4/CS5
software that enables you to use the Adobe InDesign CS4/CS5 page
layout software to design, preview, proof, and print VDP files

Darwin software packages
The Darwin VDP software is available in two software packages,
Darwin Desktop VDP software and Darwin Pro VDP software. Each
package is activated with a dongle.

Darwin Desktop enables you to create VDP jobs using rules that
contain variable text, colors, images, and pages. In addition, the Darwin
Deskop package also supports a limited number of barcodes. No
scripting or programming is required.

Darwin Pro provides enhancements to the Darwin Desktop package: In
addition to Darwin Desktop's variable text, colors, images, and pages,
the Darwin Pro package enables you to create personalized images,
many types of barcodes, data-rich charts and graphs. You can also
create personalized e-mail campaigns by combining a job definition in
Darwin Pilot with the HTML authoring abilities of DreamWeaver. The
Darwin Pro package also enables you to implement sophisticated logic



via Sun JavaScript, as well as perform complex data operations via
functions.

What is a Darwin job?
A Darwin job is a collection of all the files and entities that make up a
VDP template:

Note: It is recommended that you keep all the files and entities that relate to the
same Darwin job in one folder.

● Data source
● One or more InDesign CS4/CS5 files
● Relevant resource files, such as images and fonts
● Rules, charts, barcodes, functions, and personalized images that you

create in the Darwin VDP software
● A .dvj file

Darwin Pilot workspace
Use the Darwin Pilot workspace to access tools, manage and update
your data source, define job elements, and define the layout of a VDP
job.

The Darwin Pilot workspace appears when you double-click the Darwin
Pilot icon on your desktop. By default, Darwin Pilot displays the Data
Planner tab.

The Darwin Pilot workspace contains three tabs:

● Data Planner, where you manage and update your data source
● ToolBox, where you define job elements such as rules, barcodes,

charts, and personalized images
● Page Manager, where you define the final layout of your VDP file
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The Data Planner tab

Workspace
component

Description

Data Tools panel Contains options for managing and updating your data
source. These options enable you to add, rename, and
rearrange fields. You can also edit your data source and
immediately view the changes when you refresh the
data.

Data area Displays the records of the data source

Information bar Provides information about the location of the job and
the data source

The Data Planner tab 9



The ToolBox tab

Workspace
component

Description

Tools panel Contains a list of tools that enable you to create
different job elements, such as rules, charts, functions,
and barcodes

Variable Element
Editor area

Enables you to define the conditions and results for
rules, as well as the display and options of charts,
barcodes, and functions
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The Page Manager tab

Workspace
component

Description

Page Library
panel

● Displays icons of all the pages of the InDesign CS4/
CS5 file

● Under Page Rules, displays all the page rules that you
created on the ToolBox tab, and enables you to apply
to certain pages of your job

Pages to Print
area

● Displays thumbnails of job pages that you want to
include in your VDP job

● Includes the Production button, which enables you to
create a VDP job

The Page Manager tab 11
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3 How do I create a VDP
job? Hands-on tutorial

Overview
The aim of this tutorial is to give you hands-on experience with the
Darwin VDP software. By the time you complete this tutorial, you
should be able to use the Darwin VDP software features that enable
you to print a variable data printing (VDP) job.

To practice creating a Darwin job, you can use the files that come with
this guide. Using these files, you will create a promotional mailer for
male and female customers of a jewelry store. The jewelry store is
interested in displaying different offerings for male and female
customers based on a season (winter or summer) and on the
customer's gender. A graphic artist has already created a promotional
mailer in InDesign CS4/CS5 based on the variable data that the jewelry
store has defined. Your job is to work on the InDesign CS4/CS5 pages
and to define and insert all the variable data according to the following
criteria:

● Each mailer is personally addressed to the customer.
● The salutation varies according to the gender of the customer.
● Each mailer displays images and colors based on a specific season

and the gender of the customer.



Figure 1: Tutorial page layout and variable data—first page of the InDesign CS4/
CS5 file
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Figure 2: Tutorial page layout and variable data—second page of the InDesign
CS4/CS5 file

Note: The complete Darwin job, Jewelry_USA.dvj, contains more variable
elements than those you will create in this example. You can later explore the
complete job to discover additional rules.

Files supplied with the tutorial
The files that you need for the Jewelry tutorial are in the Sample
Files folder on the Darwin VDP software version 3.1 DVD. In this
folder you will find two subfolders that contain all the necessary files
for performing the activities in this tutorial.

Folder File Name Icon Description

Sample Files Contains all the
required folders
for the tutorial

Sample Files
\Jewelry

Contains a folder
with files for
practice and a
folder with the
final Darwin job

Files supplied with the tutorial 15



Folder File Name Icon Description

Sample Files
\Jewelry\Files
for Practice

Contains all the
files for practice

Sample Files
\Jewelry\Final
Jewelry Job

Contains all the
final Darwin job
with all the
required
elements, and the
final PDF

Files for
Practice
\Jewelry_EU
Folder

Jewelry_EU.ind
d

InDesign CS4/
CS5 file in A4
format

Files for
Practice
\Jewelry_USA
Folder

Jewelry_USA.in
dd

InDesign CS4/
CS5 file in letter
format

Files for
Practice\VI
Data

JewelryData.xl
s

Microsoft Excel
file containing the
data required for
the tutorial

Files for
Practice\VI
Resources

Contains the
variable images
required for the
tutorial

Creating a Darwin job from a data file
Create a new Darwin job by practicing with a real file.

Requirements:

● Copy the folder called Sample Job from Darwin VDP software
version 3.1 DVD to your desktop.

● JewelryData.xls—the data source
● Jewelry_USA.indd—the InDesign CS4/CS5 job

A Darwin job is based on data. You can obtain the data and create a
Darwin job in one of the following ways:

● By assigning data from an existing data source
● By manually adding fields and data records
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In this tutorial, you will learn how to create a Darwin job from an
existing data source.

1. Start Darwin Pilot.

2. In the Darwin Pilot workspace, from the File menu, select New.

3. In the New Job dialog box, select Create New Job From Data File.

4. In the Open Data File dialog box, navigate to a data source. In this
example, locate the file JewelryData.xls at Sample Jobs/
Jewelry/Files for Practice/VI Data.

5. Select the file, and click Open.

Note: If the first record in your data source contains field names, as in this
example, make sure that in the Excel File dialog box, the First record contains
field names check box is selected.

6. Click OK.

The Manage Fields window appears. It displays a table showing the
list of fields from your data source and the field types.

Note: You can add or remove fields using the Add Field and Remove Field
buttons, and you can change the order of the fields by clicking the Move Up
and Move Down arrow buttons.

Creating a Darwin job from a data file 17



7. Make sure that the field types are logical. The field type tells the
Darwin VDP software what kind of data belongs in that field. For
example, a country name consists of text, so the field type that is
assigned to Country is Text.

Note: When you work with an Excel file, the Darwin VDP software
automatically recognizes the field type.

8. Click OK.
The records appear under the Data Planner tab, in the Data area,
and a Darwin job is created.

9. From the File menu, select Save.

10. In the Save dialog box, type the desired name (Jewelry), select
the desired location, and click Save.
The Darwin job called Jewelry.dvj is saved.
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Adding InDesign CS4/CS5 pages to the Darwin job
Add Indesign CS4/CS5 pages to your Darwin job so that you will be
able to apply the variable fields to the InDesign CS4/CS5 pages.

Requirements:

● The InDesign CS4/CS5 software is running.
● An InDesign CS4/CS5 file is available. In this example, use the file

Jewelry_USA.indd, located in the Sample Files\Jewelry
\Files for Practice\Jewelry_USA folder .

● Use the Darwin job that you have created. In this example, use the
job Jewelry.dvj.

1. In the Darwin Pilot workspace, click the Page Manager tab.

2. Click the Add InDesign File  button.

3. In the Select InDesign file dialog box, locate your InDesign CS4/
CS5 file, and click Open. In this example, locate the file called
Jewelry_USA.indd.
The pages of your Indesign CS4/CS5 file are added to your Darwin
job. Thumbnails of the pages of your InDesign CS4/CS5 file appear
on the Page Library panel.

Assigning data fields to an InDesign CS4/CS5 page
Place variable data fields in containers in an InDesign CS4/CS5 page.

Requirements:

● The InDesign CS4/CS5 software is running.
● An InDesign CS4/CS5 file is available. In this example, use the file

Jewelry_USA.indd, located in the Files for Practice
folder.

● You have created a Darwin job. In this example, use the job
Jewelry.dvj.

● Your InDesign CS4/CS5 pages have been added to your Darwin job.

Adding InDesign CS4/CS5 pages to the Darwin job 19



In this example, you will place the fields containing the customer’s
name on the InDesign CS4/CS5 pages. These fields are called First
Name and Last Name in the data source.

1. In the Darwin Pilot workspace, click the Page Manager tab.
Thumbnails of the pages of the InDesign CS4/CS5 file that you
have added earlier are displayed in the Page Library panel.

2. To open your InDesign CS4/CS5 file, double-click a thumbnail of
one of the job pages.
Your file is displayed in InDesign CS4/CS5.

3. In the InDesign CS4/CS5 workspace, from the Window menu,
select Darwin CoPilot and then open all the Darwin CoPilot panels.

4. Place the customer's name on the InDesign CS4/CS5 page:

a. On the first InDesign CS4/CS5 page, select the First Name text
placeholder.

b. On the Variable ElementsScitex Ripro Archiver panel, under
Fields, double-click the field First Name.

The First Name field is displayed on the InDesign CS4/CS5 page
and appears enclosed in red brackets, like this: [First Name].
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c. On the second InDesign CS4/CS5 page, select the Last Name
text placeholder.

d. On the Variable Elements panel, double-click the field Last
Name.

5. From the File menu, select Save.

Assigning data fields to an InDesign CS4/CS5 page 21



6. To preview your file, on the Variable Elements panel, click Preview
Current Record.

The field names appear on the InDesign CS4/CS5 page with the
data from the data source.

Note: To preview other records, click Preview Next Record or Preview
Previous Record at the lower part of the Variable Elements panel.

Adding a text rule
Add a rule that controls the text that will appear in each recipient's
version of a personalized mailer.

Rules are based on information about the recipients in a data source. In
this example, you will use the field Gender in the Darwin jewelry store
data source to define the title (Ms. or Mr.) used in the mailer for each
customer. This title will be defined as a rule, and the result will appear
in the text wherever the Title rule appears.

The rule that you will add is based on the following criteria:
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● If the customer is a female, the title will be Ms.
● If the customer is not a female, the title will be Mr.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click Add New Rule .

4. In the Name box, type a meaningful rule name. In this example,
type Title, because the rule determines whether the title "Ms." or
"Mr." will be used.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Text.
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7. Click OK.

8. In the Rule Editor area, you first need to define the If statement:

a. Click the If box.
An arrow icon appears on the right side of the box and indicates
that a list of fields can be displayed (this list represents the list
of fields in the data source).

b. Click the arrow icon and in the list that appears, select Gender.

9. In the list that appears next to the If box, select the condition for
the rule. In this example, select equals.

24 Chapter 3—How do I create a VDP job? Hands-on tutorial



10. In the box that appears, type a definition for the rule. In this
example, type Female.

Note: The Darwin VDP software is case-sensitive, so make sure that the text
that you type (Female) is identical to the value that appears for this field in
the data source.

11. In the Then list, select use text as your result.

12. In the box that appears, type Ms.
13. Click the Or else box.

An arrow icon appears on the right side of the box and indicates
that a list of options can be displayed.

14. Click the arrow icon and in the list that appears, select use text.

15. In the box that appears, type Mr.

16. Under Tools, click Accept .
The Title rule is saved under Rules.

17. From the File menu, select Save.

The new rule automatically appears on the Variable Elements panel in
Darwin CoPilot. The name of the new rule consists of the rule name
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and the rule type. In this example, your rule appears on the Variable
Elements panel, under Rules, as Title _Text rule.

Applying a text rule to an InDesign CS4/CS5 page
Requirements:

A text rule. In this example, use the rule called Title_Text, which is a
text rule that you created in Darwin Pilot.

1. In the InDesign CS4/CS5 workspace, in the page layout, select the
placeholder for theTitle_Text rule. In this example, select the word
Title at the upper part of the second InDesign CS4/CS5 page.

2. On theVariable Elements panel, double-click the rule Title_Text,
which you created earlier.

3. Preview a few records to make sure that the rule was added
correctly. Check for both the male and the female customers.

Adding an image rule
Add a rule that controls the image that appears in each recipient's
version of a personalized mailer.

Requirements:

Images. In this example, use the images called Summer.tif and
Winter.tif, located in the folder VI Resource at Sample Files
\Jewelry\Files for Practice.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click Add New Rule .

4. In the Add Rule dialog box, in the Name box, type a meaningful rule
name. In this example, type Season, because the rule determines
whether a winter image or a summer image will be used.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Image.

7. Click OK.

8. In the Rule Editor area, you first need to define the If statement:

a. Click the If box.
An arrow icon appears on the right side of the box and indicates
that a list of fields can be displayed.
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b. Click the arrow icon and in the list that appears, select Season.

9. In the list that appears next to the If box, select the condition for
the rule. In this example, select equals.

10. In the box that appears, type a definition for the rule. In this
example, type Winter.

11. Define the Then statement for your image:

a. In the Then list, select use image.

b. In the box that appears, click the browse  button.
c. In the Jewelry folder, locate the image that you want this rule

to display, and click Open. In this example, open the file called
Winter.tif.

d. Click the Or else box.
e. In the Or else list, select use image.

f. Click the browse  button , and locate the image that should
be displayed if the condition is not fulfilled (that is, if the season
is not winter). In this example, open the file called
Summer.tif.

12. On the Tools panel, click Accept .

13. From the File menu, select Save.

The new rule automatically appears on the Variable Elements panel in
Darwin CoPilot as Season_Image.
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Applying an image rule to an InDesign page
Requirements:

An image rule. In this example, use the rule called Season_Image,
which is an image rule that you created in Darwin Pilot.

1. In the InDesign CS4/CS5 workspace, in the page layout, select the
desired image box. In this example, select the image box with the
Summer2011 image on the second page.

2. On the Variable Elements panel, double-click the Image rule that
you created earlier.

3. Place the image in the center of the image box:

a. On the AutoFit panel, in the Fitting Mode list, select
Proportional Fit.

b. In the Position list, select Center.

4. Preview a few records to make sure that the rule was added
correctly. Check for both the winter and the summer images.
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Adding a new result to a rule
Use the existing logic of the image rule that you created earlier to add a
result that controls the color that will appear in each recipient's version
of a personalized mailer.

Requirements:

A rule. In this example, use the Season image rule that you created
earlier.

When you use the logic of an existing rule, such as the Season rule, to
add a different result that specifies a color, the Darwin VDP software
applies a color to each recipient's mailer according to the logic of the
previously created rule.

Note: You can add several results to one If statement. You can also add a result of
the same type. For example, you can add additional text result to a text rule.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. In the ToolBox area, on the Tools panel, click Rules.

3. Select the Season rule.

4. Add a new Then statement (result) based on the Season rule's If

statement by clicking the arrow  button on the lower right of
the workspace.

5. From the menu that appears, select Add.

6. Select Color.

A Color icon appears on the rule results bar, located in the lower
portion of the workspace.
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7. Add a Then statement specifying a color based on the logic of the
image rule. That is, define a color to represent summer and a color
to represent winter.

a. Click the Then box.
b. In the box that appears, click the browse button.

c. In the Select Color window, click Import Color.
d. In the Select InDesign file window, locate the InDesign CS4/CS5

file from which you want to import the colors, and click Open. In
this example, open the file called Jewelry_USA.indd.

The colors are imported into the current Darwin job and are
displayed in the Select Color window.
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e. Select the required color. In this example, select the color
labeled Winter color.

Note: The name of the color appears in a tool tip.

f. Click OK.
g. Click the Or else box.
h. Click the browse button.
i. In the Select Color window, select the color that should be used

if the condition in the If statement is not met. In this example,
select the color labeled Summer color.

j. Click OK.

8. On the Tools panel, click Accept .
The icon of your Season image rule changes.

The new icon indicates that your image rule has more than one
type of Then (result) statement.

9. From the File menu, select Save.

Your color result is automatically added to the Variable Elements
panel in Darwin CoPilot as a color rule called Season_Color.

See also:
Rule overview on page 49

32 Chapter 3—How do I create a VDP job? Hands-on tutorial



Applying a color rule to an InDesign CS4/CS5 page
Requirements:

A color rule or a color result added to another rule. In this example, use
the color result added to your Season image rule.

Note: The color result for the Season image rule appears on the Variable Elements
panel in Darwin CoPilot as a color rule called Season_Color.

1. In the InDesign CS4/CS5 workspace, in the page layout, select the
graphic element to which you want to apply color. In this example,
select the strip of color in the lower portion of the first InDesign
CS4/CS5 page.

2. On the Variable Elements panel, select the color rule that you have
created earlier.

3. To apply the color rule to the fill of the container, click the Apply VI

to Fill  button.

Note: Color rule can also be applied to text or it's container. It can be applied
either to the fill or to the stroke of the selected element. If you want to apply a

color to the stroke of the container, click Apply VI to Stroke .

4. On the Variable Elements panel, double-click your color rule
Season_Color.

5. In the confirmation message that appears, click OK.

6. Preview a few records to make sure that the rule was added
correctly. Check for both the winter and the summer colors.
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Adding a complex image rule
Requirements:

Images. In this example, use the images called Man_Summer.tif,
Man_Winter.tif, Woman_Summer.tif, and
Woman_Winter.tif located in the folder VI Resources at
Sample Files\Jewelry\Files for Practice.

A complex rule is a rule that contains an If statement with more than
one condition (element), or a rule that contains more than one If and
Then statements. In this example, you will add a complex image rule to
define the image that will appear on the front page of each recipient's
version of a personalized mailer. The rule is based on the recipient’s
gender and the season that is associated with the recipient in the data
source.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click the Add New Rule  button .

4. In the Add Rule dialog box, in the Name box, type a meaningful rule
name. In this example, type Season+Gender, because the season
that is associated with the recipient in the data source and the
recipient's gender form the basis of the rule that determines which
image will be used on the mailer's front page.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Image.

7. Click OK.

8. In the Rule Editor area, in the If list, select Gender.

9. In the list that appears, select the first condition for the rule. In this
example, select equals.

10. In the box that appears, type a definition for the rule. In this
example, type Male.

11. Add another condition to the If statement by clicking .

12. In the box that appears, select Season.

13. In the list that appears, select the second condition for the rule. In
this example, select equals.

14. In the box that appears, type a definition for the rule. In this
example, type Winter.

15. Define the Then statement for your image:

a. In the Then list, select Use image.
b. In the box that appears, click the browse button.
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c. In the VI Resources folder, locate the image for this rule, and
click Open. In this example, open the file called
Man_Winter.tif.

16. Add another pair of If and Then statements by clicking .

17. Repeat steps 8-16 to add two pairs of If and Then statements and
the Or else statement according to the following logic:

If statement Then statement

If Gender is equal to Male
AND

Season is equal to Summer

Use Image: Man_ Summer.tif

If Gender is equal to Female
AND

Season is equal to Summer

Use Image: Woman_ Summer.tif

Or else Use Image: Woman_ Winter.tif

18. On the Tools panel, click Accept .

19. From the File menu, select Save.

The new Season+Gender rule automatically appears on the Variable
Elements panel in Darwin CoPilot.

Next:

Apply the Season+Gender rule to the image box on the first InDesign
CS4/CS5 page.

See also:
Rule overview on page 49
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Composing pages for VDP production
Select the pages and the VDP format that you want the Darwin VDP
software to use for generating your VDP job.

If you plan to print your job via a Creo color server, you must install the
Creo Color Server Job Ticket software. This software is located in the
Utilities folder of your Creo color server.

1. In the Darwin Pilot workspace, click the Page Manager tab.

2. From the Page Library panel (on the left), drag the InDesign CS4/
CS5 pages that you want to print to the Pages to Print area (on the
right).

3. Click Production.

4. In the Output Type list, select the appropriate output format. In this
example, select PDF.

Note: For large number of records, it is recommended that you use VPS,
PPML, or other VDP formats according to the designated printer.

5. Click Save.
The Darwin VDP software begins processing the files for printing,
and the InDesign CS4/CS5 Print window appears.

6. Check the settings, and modify them if necessary.
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7. Click Save, and select a location for saving your job.

The Darwin VDP software creates the required VDP output file.

You can now print your job by dragging it to a hot folder or by
submitting it to the printer via the Creo Color Server Job Ticket
software.

Note: Before you print your VDP output file, make sure that your InDesign CS4/
CS5 file is saved and closed.
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4 Creating a Darwin Job

Start a new job by either opening a data file or manually creating fields.

Data overview
Before you start working with the InDesign CS4/CS5 and the Darwin
VDP software, you need to define a list of fields that describe the data
in your job. You can either:

● Use a data source that contains a list of all the fields used in the job
(the list is usually made of the first row of the data file).

● Create a list of fields manually

It is recommended that you work with existing data files.

In the Darwin VDP software, data usually refers to information about
people; each data record usually refers to a single person. The Darwin
VDP software supports linking data from flat-file databases—that is, a
database where all data is contained in a single table. The Darwin VDP
software supports linked data from a source with a maximum of 255
columns.

You can link data from the following source file types:

File Type Description

Text file Text stored as ASCII or Unicode. The Darwin VDP
software supports any delimiter—for example,
space, semi-colon, comma.

Microsoft Excel
document

Microsoft Excel spreadsheet. For each job, you can
link to data from one Excel sheet only.

Access database Microsoft Access database. For each job, you can
link to data from one Access sheet only.

Creating a job from a data file
Create a job by opening a data source file that contains fields and data.

Requirements:

A data file, such as a Microsoft Excel file, that contains fields and
records

A job can take data from any of the following sources: a text file (with
any type of delimiter), a Microsoft Excel worksheet, or a Microsoft
Access table or query. The data source can contain only one table and
no more than 255 columns.



Note: If you are using a text file as your data source, make sure that field type is
appropriate. If it is not appropriate, change the field type according to data
content. For example, a customer number field contains a number, so the
appropriate field type is Number.

1. In the Darwin Pilot workspace, from the File menu, select New.

2. In the New Job dialog box, select Create New Job From Data File.

3. In the Open Data File dialog box, navigate to your existing data file
and select it.

4. Click Open.
The available work sheets appear in the Excel File dialog box.

Note: If the first record in your data source contains field names, as in this
example, make sure that in the Excel File dialog box, the First record contains
field names check box is selected.

5. Click OK.

The Darwin VDP software displays the list of fields and the value of
the first record.

The table that is displayed contains the fields from the data file and
values contained in your data source file. You can preview the
records in the database using the Previous and Next Record arrow
buttons below the table.
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6. Click OK.
The Manage Fields (Schema) window appears with all the required
fields.

7. Make sure that the field types are logical. The field type tells the
Darwin VDP software what kind of data will be in that field. For
example, a city name consists of text, so the field type that is
assigned to City is Text. The customer number is a whole number,
so Customer Number field type is Number.

8. Click OK.
A job is created, and its fields and data appear on the Data
Plannertab.

9. From the File menu, select Save.

10. In the Save dialog box, select the desired location and click Save.
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Creating a job manually
If you do not have a data source to work with, manually create the
required fields for your new job.

1. In the Darwin Pilot workspace, from the File menu, select New.

The New Job dialog box appears.

2. Select Create New Job Manually.

3. In the Field Name column, type a name for the first field. For
example, type Last_Name.

4. In the Field Type list, select the appropriate type of field. For
example, for the Last_Name field, select Text.

5. To add another field, click the Add Field button, type a name for the
field in the Field Name column, and select the appropriate type in
the Field Type list.

6. Create all the fields that you need for your job, and click OK.
A job is created, and its fields appear on the Data Planner tab
without any data.

Note: You can work with the new job, but some features are not available until
the job contains data. You should assign the data as soon as it is available.

7. From the File menu, select Save.
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5 Working with fields and
data

Adding a field
Add a field to the list of fields in your Darwin job when the job must
incorporate new or unused data.

1. Click the Data Planner tab.

2. Under Data Tools, click Manage Fields.

3. Click the Add Field  button .

4. In the Field Name column, type a name for the field.

5. In the Field Type list, select the appropriate type of field.

6. To move the field up or down the list, click the appropriate arrow

 button.

7. Click OK.

Types of fields supported by the Darwin VDP software
The Darwin VDP software enables you to define the following field
types:



Field type Content of the data source field

Text Free text

Number Whole numbers and decimals

Date Dates

Time Time in hours, minutes, and seconds

Image path Full path to an image file

Textfile Full path to a text file

Editing the list of fields
Change a field's name or type, move a field up or down in the list, or
remove a field from the list.

1. Click the Data Planner tab.

2. Under Data Tools, click Manage Fields.

3. Perform one of the following steps:

○ To change a field's name, select the field and type the new
name.

○ To change a field type, select the field and from the Field Type
list, select the required type.

○ To move a field up or down the list, select the field and click the
appropriate arrow button.

○ To remove a field from the list, select the field and click Remove
Field button.

Assigning data to a Darwin job
If you are replacing the current data of your Darwin job with new data,
assign the data by mapping the relevant fields in the data source to the
Darwin job fields. The purpose is to match the list of fields in your job
to the list of fields in your data source.

You need to assign data when you want to:

● Test your Darwin job with a sample data set before you produce the
job with the real data

● Reuse a job periodically with new data each time
● Add data to the fields in a job that you created manually

1. In the Darwin Pilot workspace, under Data Tools, click Assign Data.

Note: The Data Source area displays the fields and the data contained in each
field of your data source. The Previous Record and Next Record arrow buttons
enable you to move from record to record.
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2. Click the Open File button and select the new data source.

3. Perform one of the following steps:

○ Map one field: Under Data Source, select the field—for example,
a field whose name differs from the corresponding field in the
Darwin job—and drag the selected field to the corresponding
field under Darwin Job (Mapped Data).

○ Map all the fields, if all the fields in your job correspond exactly

to the data source fields: Click Assign all .

The names in the mapped fields column reflect the new
assignment.

4. Click OK.

Editing your data source
Modify your data source file directly in the Darwin VDP software.

1. On the Data Planner panel, click Edit Data.
Your original data source file appears.

2. Make the required changes.

3. From the File menu, select Save.

4. Close the data source file.

5. For the changes to take effect, on the Data Planner panel, click
Refresh Data.
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6 Working with functions

Function overview
The Darwin VDP software enables you to use predefined functions to
perform various types of operations and calculations on data from your
data source. For example, you can use a function such as Caps to
change all the text in a specific text box to uppercase letters. Examples
of common functions that the Darwin VDP software provides are sum,
average, rounding up, and rounding down. Unique functions in the
Darwin VDP software include zodiac signs and automatic numbering of
paragraphs in a text.

You can use a function as input for a rule or as a stand-alone element.

The basic workflow for creating a function is as follows:

1. Naming the function
2. Selecting a predefined function from the Function list

Note: You can find detailed information about each function and its parameters
by rolling your mouse over the name of the function.

3. Defining the function's parameters
4. Adding the function to your list of functions
5. Using the function as input to a rule, barcode, chart, or personalized

image, or placing the function on the InDesign CS3 document as a
stand-alone element

Adding a function
1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click theFunctions tab.

3. In the lower portion of the Tools panel, click Add New Function.

4. In the Name box, type a meaningful name for the function.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Function list, select a function. For example, assume that the
data source contains a field with birth dates and you want to display
people's ages in your output. You would select the function called
AgeToday.

7. Click OK.



8. In the Function Editor area, set the values for the parameters of the
functions. For the AgeToday function, you would set the values as
shown in the following example:

a. Click the P1 box.
b. In the parameter list (P1), select the source information for the

value. In this case, select Field.
c. In the list that appears next to the P1 list box, select a field (the

list of fields comes from your data source). In this example,
select Birth date.
The function calculates the person's age by subtracting the
value of the Birth date field from the current date.

9. On the Tools panel, click Accept .
Your function is saved on the Functions tab, on the Tools panel.

10. From the File menu, select Save.

Next:

Use the function as input for a rule, or apply the function directly to a
box in the InDesign CS3 document.
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7 Working with rules

Rule overview
A Darwin rule is an object that produces a result based on the content
of your data source. For example, you can create a rule that displays
images and colors based on the gender of customers listed in the data
source.

A Darwin rule consists of an If statement, a Then statement, and an Or
else statement. If the If statement (a condition) is met during output,
the Darwin VDP software applies the associated result from the Then
statement. If the condition is not met, the Darwin VDP software checks
the next If statement. If none of the rule's conditions is met, the Darwin
VDP software applies the result given by the Or else statement.

The order of the If and Then statements is important. The Darwin VDP
software checks each condition in a rule, in order, and applies the
relevant result to the first condition that is met.

The types of rule results are as follows:

● Text result—places text in a text box in which the data varies
according to the information in your data source. For example, a text
result can cause the VDP output to address male customers with
"Mr." and female customer with "Ms."

● Image result—places an image on pages in an image box in which
the image varies according to the information in your data source.

● Color result—sets a color for a textual or graphic element according
to the information in your data source. For example, a color result
can cause the VDP output to show male names in red and female
names in green.

● Page result—prints a specific page according to the information in
your data source. For example, a page result can print a cover page
with a certain design for your European customers and a cover page
with a different design for your North American customers.

● Visibility result—either shows or hides a layer in your InDesign CS3
document according to the information in your data source.

● Style result—applies a character style to variable and nonvariable
text according to the information in your data source. For example, a



style result can cause the VDP output to print male names in italics
and female names in bold. Styles are defined in InDesign CS3.

See also:
Adding a new result to a rule on page 29
Adding a complex image rule on page 34

Adding a text rule
Add a rule that controls whether specific text will appear in
personalized VDP output and if so, which text will appear.

For example, you can define a rule that places the word "Mr." before
the recipient's last name in the VDP output for a male recipient and
"Ms." before the recipient's last name in the output for a female
recipient.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click Add New Rule .

4. In the Name box, type a meaningful name for the rule.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Text.

7. Click OK.

8. In the Rule Editor area, add at least one condition, as follows:

a. In the If list, select the desired field. For example, select Gender.

Note: The If list contains a list of all the fields in your Darwin job and a list
of the functions that you have defined.

b. In the list that appears, select the next component of the
condition. For example, select equals.
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c. In the box that appears, type the next component of the
condition exactly as the text appears in the data source. For
example, type Male.
In this example, the If statement reads "If Gender is equal to
Male".

9. (Optional) To create a more complex If statement, such as "If City
is equal to Tulsa AND If Gender is equal to Female", click the AND
button in the lower portion of the workspace and define the
conditions.

10. In the Then list, select the desired text result:

○ The Use text option enables you to type the desired text in the
text box.

○ The Use file option indicates that text from a file should appear
and enables you to select the file. Click the browse button, and
navigate to a plain text (.txt ) file.

Note: The text file may contain an InDesign CS3 tagged text.
○ The Use field option enables you to select a field and display the

field's data in a text box.
○ The Don't use text option indicates that no text should appear.

11. In the Or else list, select the result that the Darwin VDP software
should apply if none of the conditions for the rule is met.

12. On the Tools panel, click Accept .
Your rule is added to the Rules list.

13. From the File menu, select Save.
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Adding an image rule
Add a rule that controls whether an image will appear in personalized
VDP output and if so, which image will appear.

For example, you can define a rule that places an American flag in the
VDP output for a recipient in the United States and a Brazilian flag in
the VDP output for a recipient in Brazil.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click Add New Rule .

4. In the Name box, type a meaningful name for the rule.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Image.

7. Click OK.

8. In the Rule Editor area, add at least one condition, as follows:

a. In the If list, select the desired field. For example, select Country.

Note: The If list contains a list of all the fields in your Darwin job and a list
of the functions that you have defined.

b. In the list that appears, select the next component of the
condition. For example, select equals.

c. In the box that appears, type the next component of the
condition. For example, type USA.

In this example, the If statement reads "If Country is equal to USA".
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9. In the Then list, select the desired image result:

○ The Use image option indicates that an image should appear
and enables you to select it. Click the browse button, and
navigate to the image file.

○ The Don't use image option indicates that no image should
appear.

10. In the Or else list, select the image result that the Darwin VDP
software should apply if none of the conditions for the rule is met.

11. On theTools panel, click Accept .
Your rule is added to the Rules list.

12. From the File menu, select Save.
Your image rule appears on the Tools panel in Darwin Pilot and on
the Variable Elements panel in Darwin CoPilot.

Next:

Apply the image rule to your InDesign CS4/CS5 page: On the InDesign
CS4/CS5 page, select the appropriate image box, and on the Variable
Elements panel, double-click the image rule that you created.

Adding a color rule
Add a rule that controls the color that will appear in a text box or a
graphic element in personalized VDP output.

Requirements:

InDesign CS4/CS5 must be running.

You can apply a color rule to a selected text box frame, a text outline,
or a specific graphic element. For example, you can define a rule that
adds a red, white, and blue strip to the VDP output of a recipient in the
United States and a green and yellow strip to the output for a recipient
in Brazil.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

Adding a color rule 53



3. Click Add New Rule .

4. In the Name box, type a meaningful name for the rule.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Color.

7. Click OK.

8. In the Rule Editor area, add a condition, as follows:

a. In the If list, select the desired field. For example, Country.

Note: The If list contains a list of all the fields in your Darwin job and a list
of the functions that you have defined.

b. In the list that appears, select the next component of the
condition. For example, select equals.

c. In the box that appears, type the next component of the
condition. For example, type USA.

9. In the Then box, click use color.
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10. Click the browse button.

11. In the Select Color dialog box, click Import Color  to import the
colors for your rule from your InDesign CS4/CS5 file.

Note: To increase the variety of colors of your Darwin job, you can import
colors from your InDesign CS4/CS5 file each time you set a color result.

12. In the Select InDesign File dialog box, locate your InDesign CS4/
CS5 file and select it.

13. Click Open.
The color swatches of your InDesign CS4/CS5 file appear in the
Select Color dialog box.

Adding a color rule 55



14. Select the desired color.

15. Click OK.
The selected color appears in the Then box.

16. In the Or else box, click use color.

17. Click the browse button.

18. In the Select Color dialog box, select a color to use for all the
records that do not meet the condition of the rule. Make sure the
color differs from the one selected earlier.

19. Click OK.
The selected color appears in the Or else box.

20.On the Tools panel, click Accept .
Your rule is added to the Rules list.

21. From the File menu, select Save.

Adding a visibility rule
Add a rule that controls whether a layer of your InDesign CS4/CS5 file
will appear in personalized VDP output.

For each layer that you want to show or hide, you need to add a
separate visibility rule.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click Add New Rule .

4. In the Name box, type a meaningful name for the rule.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Visibility.

7. Click OK.
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8. In the Rule Editor area, add a condition, as follows:

a. In the If list, select the desired field. For example, select Country.

Note: The If list contains a list of all the fields in your Darwin job and a list
of all the functions that you have defined.

b. In the list that appears, select the next component of the
condition. For example, select is equal to.

c. In the box that appears, type the next component of the
condition. For example, type USA.

9. In the Then list, select the desired visibility result:

○ The Show layer option indicates that the selected layer should
be displayed.

○ The Hide layer option indicates that the selected layer should
not be displayed.

10. In the Or Else list, select the result that the Darwin VDP software
should apply if none of the conditions for the rule is met.

11. On the Tools panel, click Accept .
Your rule is added to the Rules list.

12. From the File menu, select Save.

Next:

Apply the visibility rule to your InDesign CS4/CS5 page: On the
InDesign CS4/CS5 page, select an element in the desired layer, and on
the Variable Elements panel, double-click the visibility rule that you
created and confirm this action.

Adding a page rule
Add a rule that controls whether a specific page should appear in
personalized VDP output.

For example, for a mailer that has one cover page designed for boys
and another cover page designed for girls, you can create a page rule
that prints the required cover page according to the gender of the
recipient.
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Note: Each page rule that you define can point to only one InDesign CS4/CS5
page.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.

3. Click Add New Rule .

4. In the Name box, type a meaningful name for the rule.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Page.

7. Click OK.

8. In the Rule Editor area, add at least one condition, as follows:

a. In the If list, select the desired field. For example, select Gender.

Note: The If list contains a list of all the fields in your Darwin job and a list
of the functions that you have defined.

b. In the list that appears, select the next component of the
condition. For example, select is equal to.

c. In the box that appears, type the next component of the
condition. For example, type Male.

In this example, the If statement reads "If Gender is equal to Male".

9. In the Then list, select the desired page result:

○ The Use page option indicates that a specific InDesign CS4/CS5
page should appear and enables you to select it. Click the
browse button to display the Page Picker dialog box, and select
the InDesign CS4/CS5 page that you want to use. For example,
select the cover page that is designed for boys.

○ The Exclude pageoption indicates that no page should appear.

10. If you selected the Use page option, Click OK.
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11. In the Or Else list, select the result that the Darwin VDP software
should apply if none of the conditions for the rule is met. In this
example, you want the page designed for girls to appear if the
selected gender condition (Male) is not met, so you would select
Use page and navigate to the InDesign CS4/CS5 page that is
designed for girls.

12. On the Tools panel, click Accept .
Your rule is added to the Rules list on the Tools panel and to the
Page Rules list on the Page Manager tab.

13. From the File menu, select Save.

Next: Assign the page rule to a Darwin page: Drag the rule from the
Page Rules list (on the Page Library panel) to the Pages to Print area.
The page rule replaces the InDesign CS4/CS5 page with which it is
asociated. In this example, the rule page replaces the cover page.

Adding a style rule
Add a rule that controls whether a character style will be applied to
text in personalized VDP output and if so, which style will be applied.

Requirements:

A character style must be defined in the attached InDesign CS4/CS5
file.

A character style is a collection of character formatting attributes that
can be applied to text. Character styles that are created in InDesign
CS4/CS5 are automatically saved in the Darwin VDP software and can
be applied to rules as character style results.

For example, you can define a rule that displays red text in the VDP
output for a recipient in the United States and a yellow-bold text for a
recipient in Brazil.

1. In the Darwin VDP software Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Rules.
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3. Click Add New Rule .

4. In the Name box, type a meaningful name for the rule.

5. (Optional) In the Comments box, type a comment about the rule.

6. In the Type list, select Style.

7. Click OK.

8. In the Rule Editor area, add at least one condition, as follows:

a. In the If list, select the desired field. For example, select Country.

Note: The If list contains all the fields in your Darwin job.

b. In the list that appears, select the next component of the
condition. For example, select equals.

c. In the box that appears, type the next component of the
condition exactly as the text appears in the data source. For
example, type USA.

9. In the Then list, you can select the desired style result:

○ The use style option enables you to use a desired character style
from your InDesign CS4/CS5 file.

○ The don't use style option indicates that no style will be applied.

10. Define a specific style to the selected text:

a. In the Then list, select use style.
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b. In the box that appears, click the browse button.

c. In the Style Picker window, select a specific character style to
apply to the text and click OK.

Note: The character styles that appear in the Style Picker window are
taken from the character styles defined in the InDesign CS4/CS5 files.

11. In the Or else list, select the result that the Darwin VDP software
should apply if none of the conditions for the rule is met.

12. On the Tools panel, click Accept  .
Your rule is added to the Rules list.

13. From the File menu, select Save.
Your style rule appears on the Tools panel in Darwin Pilot and on
the Variable Elements panel in Darwin CoPilot.
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Next:

Apply the style rule to your InDesign CS4/CS5 page: On the InDesign
CS4/CS5 page, select specific text in the appropriate text box, and on
the Variable Elements panel, double-click the style rule that you
created.

Note: In case your job contains more than one InDesign CS4/CS5 file, make sure
that all your InDesign CS4/CS5 files contains the required character styles.

Adding multiple results to a rule
Use an If statement (the logic) of a rule that you created to add
different types of results (Then statements).

Requirements:

A rule that you created.

When you use an If statement of a previously created rule, to create a
Then statement that specifies a different type of result from the result
in the original rule, the Darwin VDP software applies the new result to
each record according to the logic of the previously created rule.

Note: You can add several results to one If statement.

1. In the Darwin VDP software Pilot workspace, click the ToolBox tab.

2. In the ToolBox area, on the Tools panel, click Rules.

3. Under Rules, select a rule that you created earlier.

4. In the Rule Editors area, add a new Then statement (result) based

on an existing If statement by clicking the arrow  button on the
lower right of the workspace.

5. From the menu that appears, select Add.

6. From the list that appears, select the required type of result. For
example, select Image.
An Image icon appears on the rule results bar, located in the lower
portion of the workspace.
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7. Add a Then statement specifying an image based on the logic of
the previous rule.

a. Click the Then box.
b. In the box that appears, click the browse button, and navigate to

the desired image file.

8. Click the Or else box.

9. In the Or else list, select the image that the Darwin VDP software
should apply if none of the conditions for the rule is met.

10. On theTools panel, click Accept .
The icon of your original rule changes.The new icon indicates that
your original rule has more than one type of Then statement
(result).

11. From the File menu, select Save.

Your new result is automatically added to the Variable Elements panel
in Darwin CoPilot as a new rule. The name of the new rule consists of
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the original rule name and a suffix indicating the type of the new result
—for example, Rule1_Image.
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8 Working with barcodes

Barcode overview
The Darwin VDP software supports one-dimensional (1-D) and two-
dimensional (2-D) barcodes.

Among the many types of 1-D barcodes that the Darwin VDP software
supports are Code 11, Code 39, EAN-8, EAN-13, and Code 128.

The Darwin VDP software supports the following types of 2-D
barcodes:

● Data Matrix
● PDF417
● MicroPDF417
● QR Code
● MaxiCode
● CODABLOCK-F

Selecting the correct barcode is critical to the success of your barcode
implementation plan. Here are some tips:

● If you use barcodes for a trade item that will be scanned at a retail
point of sale, you must use an EAN/UPC symbol.

● If you print a barcode with variable data such as serial numbers,
expiry dates, or measurements, use Code 128.

Adding a barcode
Use a field in the data source to generate a barcode that appears in
each recipient's version of a personalized mailer.

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. Under Tools, click Barcodes.



3. On the Tools toolbar, click New.

4. In the Name box, type a name for the barcode.

5. (Optional) In the Comments box, type a comment about the
barcode.

6. In the Type list, select the type of barcode that you want to use.

7. Click OK.
The barcode type appears in the Barcode Editor area, in the Type
box.

Note: If necessary, you can select a different type of barcode in the Type list.

8. In the Data list, select the field from which you want to create the
barcode—for example, the field called Customer Number.

9. Type the barcode dimensions:

○ If you selected a 1-D barcode, in the Bar width and Bar height
boxes, type the width and height dimensions (in mm) for the
barcode.

○ If you selected a 2-D barcode, in the Module width box, type the
required dimensions for your barcode. The units of
measurement are module width units.

Note: A module width equals the width of the smallest element (bar or
space) that a barcode is using.

10. (Optional) Perform any of the following steps:

○ Add a start character and a stop character to the barcode if such
characters are available: Select the Auto check digit check box
to make sure that The additional characters are not included in
the checksum calculation and enable the barcode to be scanned
properly.

○ To display text or numbers under the barcode, select the Human
readable check box.
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○ To define additional settings, such as Error correction level, to a
2-D barcode, click the Advanced button.

11. On the Tools panel, click Accept .
Your barcode is added to the Barcodes list.

12. From the File menu, select Save.

Applying a barcode to the InDesign CS4/CS5 page
layout

1. In the InDesign CS4/CS5 page layout, select the barcode box.

Note: Make sure that the barcode box matches the dimensions of the barcode
that you have defined earlier in Darwin Pilot.

2. In Darwin CoPilot, on the Variable Elements panel, locate the
barcode that you have created, and double-click it.

3. To preview the barcode for each customer, click the Previous
Record and Next Record arrow buttons.

Applying a barcode to the InDesign CS4/CS5 page layout 67



68 Chapter 8—Working with barcodes



9 Working with charts

Chart overview
Charts enable you to visually display data in your job. With the Darwin
VDP software, you can create multiple charts for each record in the
data source and then preview each chart in the InDesign CS4/CS5
software before you create the VDP output. You can change the
presentation of your data by choosing a different type of chart or
different colors, labels, and text properties.

A chart consists of various parts: a chart area, a chart title, x and y axes,
a legend, gridlines, and labels.

The Darwin VDP software enables you to create various types of charts:
column charts, pie charts, bar charts, line charts, area charts, and radar
charts. Each type of chart has at least two subtypes; for example, pie
chart have two subtypes; basic and 3-D.

The process of creating a new chart involves four steps:

1. Adding a new chart and selecting a chart type and subtype
2. Defining the chart display options, including titles, labels, and

background color
3. Defining series and assigning the relevant fields from the data

source
4. Previewing and adjusting the chart display options

Chart types and subtypes
Chart type Chart subtype

Column Chart Basic Stacked Percentage



Chart type Chart subtype

3-D Basic 3-D Stacked 3-D Percentage
Column Chart

Pie Chart Basic 3-D

Area Chart Basic Stacked Percentage

3-D Basic 3-D Stacked 3-D Percentage

Bar Chart Basic Stacked Percentage

3-D Basic 3-D Stacked 3-D Percentage

Doughnut
Chart

Basic 3-D

Radar Chart Basic Stacked Percentage

Line Chart Basic 3-D Basic

70 Chapter 9—Working with charts



Creating a chart
To help you easily learn how to create a chart, we will use a real-life
example. In this example, we will create a chart to compare the amount
of marketing expenses over the last three months of 2010 and 2011 of a
certain company.

We will use the data in following Excel file and demonstrate how the
text and numbers in the data source file are graphically displayed as a
column chart.

A B C D E F

Jan 10 Feb 10 Mar 10 Jan 11 Feb 11 Mar 11

20 30 40 23 54 32

27 34 38 27 51 41

1. In Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click the Charts tab.

3. Click Add New Chart .

4. In the Name box, type a meaningful name for the chart. In this
example, type Expenses.

5. (Optional) In the Comments box, type a comment about the chart.

6. In the Type list, select a type of chart. In this example, we will use
the default Column Chart.

7. In the Subtype list, select a subtype of chart. In this example, we
will use the default subtype, Basic Column Chart.

8. Click OK.
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Defining the chart display options
The Darwin VDP software enables you to customize and enhance the
look of your chart. You can add chart a title, labels, background color,
and gridlines.

You also have the option to change the colors in the chart, the color of
the labels of the X and Y axes ,and adjust the chart's dimensions.

Note: Each type of chart have a different set of display options.

1. In the Chart Editor area, under Chart Display Options, select Title.

a. In the Text box, type the desired name for your chart. In this
example, type First Quarter 2010 to 2011.

b. Define the font, style, size, and color for the title. In this example,
keep the default values.

2. Select Labels. In the Labels list, you can select one of the following
options:

○ Off--do not display labels
○ Values--display values from the data source. For example, if the

sum of the marketing expenses on Jan 10 is 20($K), the number
20 will appear on the top of the appropriate column.

○ Percentage Values--display the percentage values of the values
in the data source.

a. In the Label list, select Values.
b. Define the font, style, size, and color for the labels. In this

example, keep the default values.

3. Select Background.

a. In the Use list, you can select Color or Transparent Background.
In this example, keep the default Color option.

Note: A transparent background for a chart is supported only in PDF
output.

b. To change the color of the chart's background, click the Color
box.
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c. In the Select Color window that appears, select the desired color
for the background. In this example, keep the default settings.

4. Select Title of X Axis.

a. In the Text box, type the required name for the X axis. In this
example, type Months.

b. Define the font, style, size, and color for the X-axis title. In this
example, keep the default values.

5. Select Title of Y Axis .

a. In the Text box, type the required name for the Y axis. In this
example, type Expenses ($K).

b. Define the font, style, size, and color for the Y-axis title.

6. Select Labels on X Axis.

a. If you want to display labels on the X axis, make sure that the
Enable check box is selected.

Note: The labels that appear on the X-axes display the names of the fields
in the first series.

b. Define the angle of the labels, font, style, size, and color for the
labels on the X-axis. In this example, keep the default values.

7. Select Labels on Y Axis.

a. If you want to display labels on the Y axis, make sure that the
Enable check box is selected.

b. Define the angle of the labels, font, style, size, and color for the
labels on the Y-axis. In addition, you can define the number of
tick marks. In this example, keep the default values.

8. Select Gridlines. In the Gridlines list, you can select one of the
following options:

○ None—no gridlines are displayed
○ X Axis—only the X-axis gridlines are displayed
○ Y Axis—only the Y-axis gridlines are displayed
○ X and Y Axes—both the X-Axis and Y-axis gridlines are

displayed
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9. In this example, select the X and Y Axes.

10. Select Chart Dimensions.

11. In the Width and Height boxes, type the required values in
millimeters. In this example, keep the default values.

Note: Make sure that the width and height values that you set in the Chart
Dimensions area are identical to the width and height values of the InDesign
CS4/CS5 page box that will contain the chart.

You have completed defining the chart display options, now you will
learn how to define the chart data.

Defining the chart data
In the Chart Data area, you define the series and fields that will apear
in the chart.

Each series is a folder that contains the fields that you want to use in
your chart. Depending on the type of chart that you want to use, you
can add as many series as you want and assign fields accordingly. In
this example, we want to create a chart that compares last quarter
expenses for 2010 and 2011, so we need two series: series 1 for 2010
and series 2 for 2011.

1. To name Series 1, under Chart Data, in the Name box, type the
required name for your series. In this example, type 2010.

2. To add another series, click Add Series .

3. Make sure that Series 2 is selected and then in the Name box, type
the required name. In this example, type 2011.

4. Select Series 1.

5. Click Add Fields and Functions , and select the fields that you
want to show in the chart. In this example, select the following
fields: Jan 10, Feb 10, and Mar 10.
The required fields are assigned to Series 1.

6. Click the Color box.

7. In the Select Color window that appears, select a color for the
column of series 1 and click Ok.

8. Select Series 2.

9. Click Add Fields and Functions , and select the fields that you
want to show in the chart. In this example, select the following
fields: Jan 11, Feb 11, and Dec 11.

Note: If you have multiple series, only the names of the fields in Series 1 will be
displayed as labels on the X-axis.

10. Click the Color box.
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11. In the Select Color window that appears, select a color for the
column of series 2 and click Ok.

12. On the Tools panel, click Accept .

13. From the File menu, select Save.

You can save your chart at any stage of your work. Once you save a
chart, it is added to the Variable Elements panel in Darwin CoPilot with
a chart icon, and to the chart list on the Tools panel.

Previewing a chart in the InDesign CS4/CS5 page
layout

After defining the chart display options and its data, you can preview
your chart in the InDesign CS4/CS5 page layout and adjust the chart
display options if necessary.

1. In the InDesign CS4/CS5 page layout, select the chart placeholder
box.

2. To apply the chart to the box, in Darwin CoPilot, on the Variable
Elements panel, locate the chart that you have created, and double-
click it.

3. To preview the chart, click Preview Current Record.
The chart is displayed in the chart box:
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4. To improve the chart display, in Darwin Pilot, you can adjust the
chart display options as necessary.

Adjusting the margins size
The margins area is the area around the chart graphic. The titles and
labels of the chart appear in the margins area. The Darwin VDP
software enables you to enlarge or reduce the margins size for different
purposes. You can reduce the size of the chart graphic area by
enlarging the margins size to better fit the titles and labels, or you can
enlarge the chart graphic area by reducing the margins size.
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1. Select Chart Dimensions.

2. To adjust the margins size, clear the Maintain proportions check
box.

3. In this example, we will enlarge the size of the chart graphic area.
To do this, we will set the margins size to 10 mm (instead of the
default 15 mm).

Note: It is recommended that you use the ruler guides in InDesign CS5 to
define the desired margins size.

4. Now that you have adjusted the margins size, preview your chart
again:

a. In the InDesign CS5 page layout, select the chart placeholder
box.

b. Click Preview Current Record.

Your chart is displayed in the chart placeholder box. You can adjust
the chart dimensions as necessary.
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Adding a legend to the chart
Learn how to add a legend to your chart and adjust the chart graphic
area (the plot area) accordingly.

1. In Darwin Pilot, in the Chart Display Options area, select Legend

2. Select the Show legend check box.

3. In the Location list, you can define the location of the legend in the
chart. In this example, leave the default option, Top Right, as is.

4. Under Tools, click Accept.

5. Open your InDesign CS4/CS5 file.

6. On the Variable Elements panel, click Preview Current Record.

The legend appears and overlaps the chart graphic area (the plot
area).

7. To make sure that the legend does not overlap the chart graphic, in
the InDesign CS4/CS5 add ruler guides to define the desired new
plot area (green ruler guides appear in the chart below to mark the
new resized chart graphic area). The new desired plot area
minimizes or eliminates overlapping between the legend and the
chart graphic area.
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8. Measure the distance between the new ruler guide on the right (the
green ruler guide) to the margin on the left (the orange line). This
measurement represents the width of the new plot area. In this
example, the width of the new plot area is 58 mm.

9. Measure the distance between the new ruler guide at the top of the
plot area (the green ruler guide) to the margin at the bottom of the
chart (the orange line). This measurement represents the height of
the new plot area. In this example, the width of the new plot area is
51 mm.

10. In Darwin Pilot, under Chart Display Options, select Chart
Dimensions.

11. In the Width of plot area box, type 58.

12. In the Height of plot area box, type 51.

13. Under Tools, click Accept.

14. Preview your chart in the InDesign CS4/CS5 document.
Resizing the plot area, minimizes or eliminates overlapping of the
legend and the chart graphic.
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10 Working with
personalized images

Personalized images overview
The Darwin VDP software enables you to create graphically rich,
personalized images for VDP jobs—for example, to display each
recipient's name in the form of a signature on a baseball.

To create personalized images, you use Adobe Photoshop CS4/CS5
software. The Darwin VDP software supports the following Photoshop
CS4/CS5 features:

● Text layers: You can place variable text in a text layer. All the effects
previously applied to the layer are applied to the variable text.

● Smart Object layers: You can place a variable image in a Smart
Object layer, which you can scale, rotate, warp, and transform while
preserving image quality.

● Actions: You can select a Photoshop CS4/CS5 action to be applied
during image generation.

Note: Make sure that you use unique names for layers that contain variable
content.

Creating a personalized image
Requirements:

● Adobe Photoshop CS4/CS5 must be running.
● A .psd file that was created in Adobe Photoshop CS4/CS5

1. In the Darwin Pilot workspace, click the ToolBox tab.

2. On the Tools panel, click Personalized Images.

3. Click Add New Personalized Image .



4. In the Name box, type a meaningful name for the personalized
image.

5. (Optional) In the Comments box, type a comment about the
personalized image.

6. Click OK.

7. In the Personalized Image Editor area, click the Browse button to
locate your .psd file.

8. In the Select Photoshop file window, locate the required .psd file,
select it, and click Open.

The Photoshop CS4/CS5 text layers and Smart Object layers are
displayed under Layers. The Darwin job fields and rules are
displayed in a list on the right, under Storage.

9. Under Layers, select the layer that contains the information you
want to be variable.
The content of the layer appears in the Content box.

10. If you want to create a personalized image in a text layer, perform
the following steps:

a. In the Content box, select the text that you want to replace with
variable information, for example a name.

b. Under Storage, double-click the field(s) or rule(s) that you want
to be used as variable information in the personalized image. For
example, First Name.
The field(s) or rule(s) appear in the Content box.

Note: In addition to fields of variable information, you can also add static
text to the Content box. The static and variable text in the Content box will
replace all the text in the layer.
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11. If you want to create a personalized image in a Smart Object layer,
perform the following steps:

a. Under Storage, double-click an image rule or a image file-path
field.
The field(s) or rule(s) appear in the Content box.

12. Repeat steps 9-11 for each layer in which you want to have variable
information.

13. To add a Photoshop CS4/CS5 action, select the Use Photoshop
Action check box.

Notes:

● Actions must be saved as Action Set for the Darwin VDP software to
recognize them.

● The Photoshop CS4/CS5 action is applied to the .psd file during image
generation after the content has been replaced.

14. Click the Browse button.

15. In the Add Photoshop Action window, select the required action.

16. In the Output Folder box, type the path to which you want to save
the generated images, or click the Browse button to locate the
required path.

17. From the File menu, select Save.
Your personalized image appears on the Variable Elements panel
in Darwin CoPilot.

18. Now, you can preview the image.
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Applying and previewing a personalized image
Apply a personalized image to an InDesign CS4/CS5 page and preview
the images.

1. In the InDesign CS4/CS5 workspace, in the page layout, select a
box that will contain the personalized image.

2. On the Variable Element panel, double-click the personalized
image that you have created.

3. Click Preview Current Record.
The first name of the first record appears.

4. To preview the personalized image for the other records, click the
Previous Record and Next Record arrow buttons.

Generating a personalized image
You have two options to generate personalized images:

● You can generate the personalized images during production, a
process that results in extending the production time.

● You can generate all the personalized images before production and
use the pre-generated images while creating the VDP output. This
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option saves time during production and improves the preview
speed.

In the Personalized Image Editor area, click Generate.
The personalized images are generated according to the fields you
selected and saved in the designated output folder.
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11 Placing variable elements
on InDesign CS4/CS5
pages

Darwin CoPilot Overview
After defining the fields for your Darwin job and creating rules, charts,
or barcodes, you use Darwin CoPilot to apply the variable content to
InDesign CS4/CS5 pages and save them as Darwin documents.

Darwin CoPilot consists of four panels: Variable Elements, AutoFit,
Darwin Preflight, and Frame Elements. You can access the Darwin
CoPilot panels from the InDesign CS4/CS5 Window menu.

Darwin CoPilot enables you to specify where to place variable data on
each page. You can place certain types of data in text boxes and other
types of data in image boxes. Text boxes can hold Darwin fields
(containing text, numbers, dates, or times), color rules, text rules, and
non-variable (fixed) text. Image boxes can hold image rules and charts.

Darwin CoPilot also enables you to preview your pages on the screen to
see how they will look when printed with the variable data.



Placing variable text fields and rules on an InDesign
CS4/CS5 page

Specify where variable text fields (containing text, numbers, dates, or
times), color rules, and text rules should appear on your InDesign CS4/
CS5 page.

Requirements:

● Darwin Pilot must be running.
● InDesign CS4/CS5 must be running.
● The Darwin CoPilot panels must be displayed.

Note: Variable data can be placed only on individual pages, not on a master page.

1. Open an InDesign CS4/CS5 file, or create a new one.

2. In the applicable text box on the InDesign CS4/CS5 page, select the
placeholder text that you want to replace. For example, select the
words Last Name.

3. In Darwin CoPilot, on the Variable Elements panel, double-click the
field that should replace the selected phrase. In this example, you
would double-click Last_Name.
The field appears on the page, enclosed in square brackets like this:
[Last_Name].

Next: It is recommended that you save the InDesign CS4/CS5 file as a
Darwin document.

Previewing variable data on an InDesign CS4/CS5
page

Scroll through the records in your job to preview how each page looks.

Requirements:

You have placed the variable text fields and rules on an InDesign CS4/
CS5 page.

The preview options in the lower portion of the Variable Elements
panel enable you to search for records, preview the current InDesign
CS4/CS5 page to see how it will look with the variable data and the
results of rules, show or hide VI brackets, and reset the VI preview.
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1. In the InDesign CS4/CS5 workspace, on the Variable Elements
panel, click Preview Current Record.
The data from the specific record that you selected appear in the
fields on the InDesign CS4/CS5 page.

2. (Optional) To preview the page with another record, click Preview
Next Record or Preview Previous Record.

Checking for hidden text
Have the Darwin VDP software check whether text from the records in
the data source is too long for the designated text box and therefore is
not displayed in its entirety.

1. On the Darwin Preflight panel, in the Hidden Text list, select the
area in which you want the Darwin VDP software to search for text
that is not displayed in its entirety:

○ Selected Boxes
○ Current Page
○ Document (the entire document)

2. Click the Check for Hidden Text arrow button.
The Darwin VDP software checks the area that you selected. If
there is hidden text, a message appears in the lower portion of the
Check for Hidden Text dialog box, and a hidden text icon appears in
each text box in which text is not displayed in its entirety.

3. (Optional) To view the hidden text, in the Preflight Results dialog
box, double-click a Hidden Text message.

The location of the text box with the hidden text appears.
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Note: A message appears for each instance of hidden text that the Darwin
VDP software finds.

Next:

If some of the text is not displayed in a text box, enlarge the box so that
the entire text will fit in.

Resizing text so that it will fit in a text box
Use the AutoFit panel to have the font size and the horizontal scale
automatically adjusted in a specific text box.

The AutoFit option is not available for text that is in a separate file.

1. On the InDesign CS4/CS5 page, select the text box whose font size
you want the Darwin VDP software to adjust.

2. If the AutoFit panel is not already open, open it from the Window
menu.

3. On the AutoFit panel, in the Size boxes, enter percentage values
that indicate a reduction or enlargement of the font in the selected
text box:

○ To have the Darwin VDP software reduce the font size, enter a
value less than 100% in the Min column. The value represents
the smallest font size (as a percentage of the original font size)
that the Darwin VDP software should generate for this text box.
For example, if you enter 20%, the Darwin VDP software will
reduce the font as much as necessary to fit the text into the box,
but the reduced font will be no smaller than 20% of the original
font.

○ To have the Darwin VDP software enlarge the font, enter a value
greater than 100% in the Max column. The value represents the
largest font size (as a percentage of the original font size) that
the Darwin VDP software should generate for this text box. For
example, if you enter 130%, the Darwin VDP software will
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enlarge the font as much as necessary to fill out the text box, but
the enlarged font will be no larger than 130% of the original font.

Note: If you do not want the font size of the text changed, make sure that both
values are set to 100%.

The Darwin VDP software reduces or increases the font size and
leading (weight) as necessary, according to your specifications.

4. In the H. Scale boxes, enter percentage values that indicate a
horizontal scaling down or scaling up of the text in the selected text
box.

○ To have the Darwin VDP software scale down the text
horizontally, enter a value less than 100% in the Min column.
This value represents the minimum amount of scaling down (as
a percentage of the original horizontal length of the text) that
the Darwin VDP software should generate for this text box. For
example, if you enter 20%, the Darwin VDP software will scale
down the text horizontally as necessary to fit into the box, but
the scaled-down text will be no shorter than 20% of the original
text.

○ To have the Darwin VDP software scale up the text horizontally,
enter a value greater than 100% in the Max column. This value
represents the maximum amount of scaling up (as a percentage
of the original horizontal length of the text) that the Darwin VDP
software should generate for this text box. For example, if you
enter 130%, the Darwin VDP software will scale up the text
horizontally as necessary to fill out the box, but the scaled-up
text will be no longer than 130% of the original text.

Note: If you do not want the horizontal length of the text changed, make sure
that both values are set to 100%.

When you print the job, the text is horizontally scaled down or up
as necessary, according to your specifications.

Checking for the longest line of text
Have the Darwin VDP software find the record that has the longest
text in a specified text box so that you can check whether the text will
fit into the box.

As it checks the length of text, the Darwin VDP software takes into
account the physical space occupied by the characters. This space is
affected by the number and width of the characters and the character
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style (such as bold). If the longest text fits into the specified text box,
the text of all the other records is most likely to fit, too.

1. On the InDesign CS4/CS5 page, place the pointer in the text box
that you want to check.

2. On the Darwin Preflight panel, click the Longest Line arrow button.
The Darwin VDP software checks the selected text box and
displays the record with the longest amount of text. If the text box
contains two or more fields, the Darwin VDP software checks the
combined length of text in all the fields in a text box.

Example:

A text box contains the following text:

[First name][Last name] text text text text text text text
text text text [Age]. In the Darwin data source, the field
values are as follows:

First
name

Last
name

Age

John Brown 35

Alexan
der

Trump
et

42

The Darwin VDP software determines that the longest
combination of fields in the text box is "Alexander
Trumpet, 42" (and not "John Brown, 35").

Next:

If the longest text causes other text—variable or nonvariable—to
overflow the text box, enlarge the text box and check for hidden text in
other boxes in the document.

Formatting the display of rules and fields in a text box
The Frame Elements panel enables you to view all the rules and
variable fields that are assigned to a selected text box. When you click
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a rule or field in the Layout box, the rule or field is highlighted on the
InDesign CS4/CS5 page.

1. On the InDesign CS4/CS5 page, select the text box with the rules
or fields that you want to view.

2. Select the rule or field that you want to edit.

3. Perform any of the following steps:

○ To edit the number of decimal places, from the Precision list,
select the maximum number of digits that you want to appear to
the right of the decimal point.

○ To add trailing zeros if there are fewer decimal places than the
number defined in the Precision box, select the Add trailing
zeros check box.

○ To add commas to separate thousands, select the Use thousand
separator check box.

○ To display InDesign tagged text with the correct attributes (such
as font and paragraph style), select the Is styled text check box.

Note: The InDesigned tagged text can be found in text file fields or text
rules.

Placing variable graphic elements on an InDesign
CS4/CS5 page

Specify where variable images, charts, barcodes, and personalized
images should appear on an InDesign CS4/CS5 page.

Requirements:

● Darwin Pilot must be running.
● InDesign CS4/CS5 must be running.
● The Darwin CoPilot panels must be displayed.

To place variable images on an InDesign CS4/CS5 page, you actually
replace a placeholder with an image rule. The image rule is based on
information in the data source and defines which image will appear in
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the image box. Image boxes or unassigned boxes can hold only image
rules and charts.

1. Open an InDesign CS4/CS5 file, or create a new one.

2. Select the applicable image placeholder.

3. In Darwin CoPilot, on the Variable Elements panel, double-click the
image rule or chart that you want to put in the image box.

Note: You can use the AutoFit panel to have the Darwin VDP software
automatically resize the image or chart so that it will be proportional to the
image box.

An icon of an image or a chart appears in the image box to
represent the assigned image rule or chart.

Next:

It is recommended that you save the InDesign CS4/CS5 file as a
Darwin document.
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Resizing and positioning an image to fit in an image
box

Use the AutoFit panel to have the size of an image automatically
adjusted in a specific image box.

1. On the AutoFit panel, in the Fitting Mode box, select the desired fit.
For example, select Proportional Fit to enlarge the image
proportionally.

2. In the Position box, select the desired position for the image. For
example, to position the image in the top left corner of the image
box, select Left Top.

Saving an InDesign CS4/CS5 page as a Darwin
document

After placing variable elements on an InDesign CS4/CS5 page, save it
as a Darwin document so that is will become part of the Darwin job.

Requirements:

● Your InDesign CS4/CS5 page must contain variable elements.
● Your Darwin job must be open.

1. From the InDesign CS4/CS5 File menu, select Save.
If you are saving the document for the first time, the following
message appears:
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2. Click OK.

● The InDesign CS4/CS5 document is saved and associated with
the selected Darwin job.

● The Darwin VDP software automatically adds the pages of the
saved file to the Page Library panel on the Page Manager tab in
Darwin Pilot.
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12 Managing pages in
Darwin Pilot

Page Manager overview
You use the Page Manager tab to manage and work with the pages of
your Darwin job.

The Page Manager tab contains two sections:

● Page Library panel: Contains InDesign CS4/CS5 files that were
saved as Darwin documents. Under each InDesign CS4/CS5 file,
thumbnails of its pages are displayed. Each thumbnail represents an
individual page of an InDesign CS4/CS5 file. On this panel, you can
also find a list of all the page rules that you created.

● Pages to Print area: Displays the pages that will be included in the
VDP output. Each item in this area is either an actual InDesign CS4/
CS5 page or a page rule. The page rule indicates that a specific
InDesign CS4/CS5 page is either included in or excluded from the
VDP output.

In the following example, the front page of the VDP output is an actual
InDesign CS4/CS5 page, whereas the back page is represented by a
page rule. This rule determines which of the two InDesign CS4/CS5
pages shown on the Page Library panel will be included in the VDP
output.



Working with pages
After adding variable elements to InDesign CS4/CS5 pages, you use
the Page Manager tab to plan the layout of your Darwin document.

In order to plan the layout of your VDP output and define the pages or
page rules that will be included in your VDP output, you first need to
add the InDesign CS4/CS5 pages to your Darwin job.

1. Add InDesign CS4/CS5 pages to your Darwin job by one of the
following ways:

○ Dragging an InDesign CS4/CS5 page to the Page Manager area
in Darwin Pilot

○ Importing an InDesign CS4/CS5 page to Darwin Pilot, by
clicking the Add InDesign File

Note: If you want to add an InDesign CS4/CS5 page that was already
associated with a different Darwin job, a message will prompt you to
create a copy of this page.
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○ Opening an InDesign CS4/CS5 file, adding variable content to it,
and saving the file as a Darwin document

When you add InDesign CS4/CS5 files to the Darwin job, the job
displays each page of the InDesign CS4/CS5 file as a separate page
on the Page Library panel on the Page Manager tab. For example, if
an InDesign CS4/CS5 file contains four pages, the Darwin VDP
software adds four pages to the Page Library panel.

2. Drag the pages or the page rules that you want to include in your
VDP output from the Page Library panel to the Pages to Print area.

You can change the order in which the pages of a job are printed by
dragging the pages up or down in the Pages to Print area. You can
also enlarge and reduce the size of the pages in this area, for
review.

3. To delete a page:

○ In the Page Library area—select the file that you want to delete
and click the Remove InDesign File button.

Note: In this area, you cannot delete individual pages, only an entire file.
○ In the Pages to Printarea—select the page that you want to

delete and press the DELETE key.

Next:

After defining the desired pages for your VDP output, you can go on to
the production stage.
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13 VDP output

Producing VDP output
After defining the pages for your job, you can produce your VDP output.
In the production stage, the Darwin VDP software defines which
records are printed and how they are sorted.

1. To produce a VDP job, in the Page Manager area, click the
Production button.
The Production window appears.

2. In the Output Types list, select the required type.

The Darwin VDP software provides the following output types:

● PDF
● VPS—Creo Variable Print Specification
● VIPP
● Optimized PostScript
● PPML
● PPML/VDX

3. Click Save.
When you save your job, the Darwin VDP software preflights the
job and detects problems. As a result, warnings or errors might be



generated and displayed under Warnings/Errors List. Errors are
considered more serious than warnings.

● Warnings: The Darwin VDP software generates warnings when
some rule elements are missing—for example, when a Then
statement in a text rule is blank.

You can decide to continue the production even if there are
warnings (as long as there are no errors). However, the Darwin
VDP software does not print the records that caused the
warning.

● Errors: The Darwin VDP software generates errors when the
following problems appear during production:

○ No pages were defined, or a page was defined with no layout
or page rule assigned to it.

○ Items are incomplete. This problem occurs, for example,
when image rules have no images linked to them or when the
Darwin VDP software cannot create a barcode or a chart
because of missing information.

4. Solve the problem(s) causing the errors.

5. Click Production.

6. Click Save.
The InDesign CS4/CS5 Print dialog box appears.

7. Click Save.

8. In the Save PostScript File window, locate your Darwin job folder,
and click Open.

9. Click Save.
The Darwin VDP software creates your VDP output according to
the required settings.
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14 Managing Darwin jobs

Collecting and packaging job resources
Save all the Darwin job resources and linked items in one folder so that
you can organize them easily and compress them for transferring to
another computer (from a Mac to a Windows-based computer or the
other way around).

Requirements:

Your Darwin job must be open.

Note: It is recommended that you save all the job resources and linked items in one
folder while you create your job. However, if you did not save all the elements in
one location, you can use the Collect and Pack Files option to gather all the
elements into one folder.

1. In Darwin Pilot, from the File menu, select Collect and Pack Files.

2. In the Package Name box, type the name of the folder where you
want to place all the job elements.

3. In the Package Location box, navigate to the desired location for
your folder.

4. Select the required Pack Options.

Note: If you need to move your packaged Darwin job to another computer, it is
recommended that you select the Archive as DRWN File option. When you



select this option, the Darwin VDP software packages and compresses your
job.

5. Click Pack.
An Adobe InDesign CS4/CS5 warning message instructs you to
obtain permission for your fonts.

6. Click OK.
The Darwin VDP software packages your job and a message
informs you that the process has been completed successfully.

7. Click OK.

8. In the Collect and Pack to Folder window, click Close.
Your packaged job appears in one folder in the required location.

Importing a compressed (DRWN) Darwin job
Use the Import DRWN File option to copy Darwin jobs from another
computer or to work with jobs created in the Darwin VI Authoring Tool
for InDesign version 2.0.

Requirements: A compressed (DRWN) job

1. In Darwin CoPilot, from the File menu, select Import DRWN File.

2. In the DRWN File Name box, click the browse button and locate
the compressed Darwin job that you want to import.

3. In the Import to Folder box, click the browse button and select the
location in which you want to save the extracted Darwin job.

4. Click Import.
The Darwin VDP software extracts your compressed job and
displays a message when the process is complete.

5. Click OK.
Your extracted Darwin job appears in the designated folder in the
required location.

Updating file locations
Check for broken links and update them to prevent problems during job
production or to correct errors that occur during production.

When you change the name or the location of a linked item, such as an
image in an image rule or a linked InDesign CS4/CS5 file, the link in the
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job breaks. You must correct the broken links before you can produce a
job successfully.

1. In Darwin Pilot, from the File menu, select Missing Links.

The Missing Links window lists the files that are missing in the
selected job.

2. (Optional) Filter the list of missing files by selecting the relevant
element type in the Show link types list.

3. Select the file that you want to update its location.

4. Click .

5. In the Select new location window, locate the required file and click
Open.
The path is updated, and the file is no longer listed in the Missing
Links window.

Note: If you want to view a list of the missing links that you resolved, from the
Show link types list, select Resolved links.

6.
○ To accept the updates and close the Missing Links window, click

OK.
○ To cancel all your updates and close the window, click Cancel.
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